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“How would you like your steak Sir?”
“Medium rare please” I reply, in the sure knowledge that in this particular restaurant, the steak will be cooked 
exactly to my liking; it will be the right colour. If I happened to be in Paris, I would probably ask for “Well done” as 
the French have different interpretation of how a steak should be cooked; it will come out a different colour.

The slightly obtuse example above does in fact illustrate very well the differing perceptions of colour and a need 
to define it in a universally recognized way. If you are photographing a petrol station with a particular shade of 
green on its canopy, it is possible to accurately reproduce that shade in a variety of media worldwide, but colour 
management is the only way to guarantee accuracy.
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1traP What is colour?
Very simplistically, Colour can be described as an experience, or the 
experience of an event. The event is the coming together of three 
components: Light, the object and an observer. Light is reflected 
from the object and is absorbed by specialist photoreceptor cells, 
the rod and cone cells. Large numbers of these three colour 
sensitive receptors, situated in the retina at the back of the eye, are 
stimulated by the light and electrical signals are sent to the brain, 
creating the experience of colour.

Every individual experiences colour in a slightly different way and as 
far back as 1920s an international organisation, the Commission 
Internationale De L'eclairage (CIE) or the International Commission 
on Illumination, was working to define colour. In 1932, they 
developed a model of colour perception for an average person, the 
'standard observer', based on experiments in which a group of 
people were asked to match various colours by mixing three 
coloured lights. These values became the CIE LAB (or XYZ) values 
which are still used over 70 years later and form the basis for the 
creation of all ICC colour profiles.
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What is colour?
Colour spaces can be defined as maps defining ranges of colour. CIE Lab is a 
colour space that defines the colour perception of a typical person. Because 
that space is not restricted to a particular device, it is called a Device 
Independent space. 

Device Dependent spaces like RGB and CMYK represent the CIE Lab colours 
that can be reproduced by physical devices such as monitors and printing 
presses. This range of colour can be mapped or profiled to describe the 
colours that the device can reproduce. These profiles, defined by standards set 
by the ICC, the International Colour Consortium, are the cornerstone of colour 
management systems.
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What is Colour Management?
The left below diagram explains this a little more clearly. Every device has its own profile. For the 
camera or scanner, it would be described as an 'Input Profile' and for the printer or printing press, 
the profile is an 'Output Profile'. The colour management system is typically a part of the 
computer's operating system, although some companies like Adobe incorporate their own system 
within their software, giving the choice of which system you use. Of key importance is to make sure 
that you and your customers are using the same system. 

Forming a central part of the colour management system is the PCS; the Profile Connection Space, 
the universal space through which colours are translated by the CMS, the colour management 
system. The PCS is, perhaps unsurprisingly, based on CIE XYZ, the model of standard human colour 
perception.

Colour management is the system that allows colour to be controlled, from the taking of the 
picture, to the monitor to final output. It does this by transforming data encoded for one device such 
as a digital camera or scanner into data that reproduces on print the same colours as scanned or 
photographed. Where exact colour matching is impossible, the output should be a pleasing 
approximation of the original colours. The process is designed to be fully repeatable, giving the 
knowledge and confidence that what is seen in the viewfinder should be reproducible on the web, 
on a print, or in a magazine. In other words, if you take a picture of your dog in the garden and then 
make a print from it, it should still look like a Golden Retriever and not a Red Setter.

The diagram left gives a very simplified over view of how colour management works
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What is Colour Management?
The best analogy to describe the system of colour management is to think of language. My first thought was the 

European parliament, but in fact that is an inefficient system with translators working from French into Polish or 

Finnish into Greek. Colour management is more simple, because it uses a universal language, the profile connection 

space. If we think of each device as speaking a different language, the colour management system uses the profile 

for the input device to translate the colour information firstly into the universal language and then secondly, into the 

language for the output device. At the same time, the monitor profile is also used to translate the information, so 

that an accurate picture is displayed on the monitor. 

Colour profiles define how a picture looks. EOS cameras can only tag sRGB images with a colour profile, despite having the 

ability to shoot in sRGB or Adobe RGB. Seen to left, an image shot in sRGB and with the correct profile assigned. To right, the 

same image has been mistakenly tagged as Adobe RGB. The spaces are quite different and the image appears garish and 

over saturated because the computer has been given the wrong information about the colours in the picture.
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RGB and CMYK
So far we have talked about the theory of how colour 

management works, but there is another important 

element which is the practical implementation. When 

it comes to colour there are typically two forms of 

colour that photographers have to deal with: Red 

Green Blue or (RGB) and Cyan Magenta Yellow Black 

(CMYK).

Red Green and Blue are primary colours and they are 

also additive colours. If we add them together we 

make white. This is only possible whilst working with 

light such as the camera or monitor. As soon as we try 

printing these colours, a subtractive process takes 

place and like CMYK printing, we end up with black.

RGB, additive colour: Working with light, rather 

than ink, the adding of one colour to another 

results in a lighter colour CMY, subtractive colour

With ink, the adding of one colour to another results in a darker colour. 

This is called a subtractive process. Inkjet printers, like printing presses 

work in four (or six colours) using CMYK inks. The fourth colour, black, 

is used to strengthen the darker colours and on many printing presses 

it is used to replace some of the other inks as black ink is far cheaper. 

This is a complex process and beyond the scope of this article, but is 

known as Grey Component Replacement (GCR).
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RGB and CMYK
CMYK is a much smaller colour space and it has a 
much more restricted gamut by comparison with 
RGB. The diagram shows how much smaller the 
Euroscale coated space is than Adobe RGB. This 
presents problems for photographers and printers 
alike, because the colours from the camera, typically 
in or converted to Adobe RGB, have to be squeezed 
into the smaller space. 

To do this, information has to be lost in the process 
and one of the decisions that has to be made is how 
the transformation is achieved and what 
compromises will be made. 'Rendering Intent' 
determines whether colours will be translated exactly 
from one space to another (Absolute Colorimetric) or 
whether the general feeling of the image will be 
translated (perceptual). Some RGB colours cannot be 
reproduced by the CMYK process. These colours are 
termed 'Out of Gamut'. Within Photoshop there is a 
soft proofing tool that allows the result of a 
transformation between one colour space and 
another to be seen in advance. This subject will be 
covered in more detail in a future article.

Nick Wilcox-Brown.

Shown above is a 3 dimensional model of two common 

colour spaces, Adobe RGB and inside it, the smaller CMYK 

space Euroscale Coated v2. Adobe RGB is a wide space 

and one of the options for output for Canon EOS digital 

cameras. Euroscale is a generic CMYK space, designed to 

represent a typical European printing press, printing on 

coated paper. When converting from RGB to CMYK,the 

information in the bigger space has to be conveyed by the 

more limited range of colours in the smaller space.



How to set up colour management

ruoloCfoegaugnaLehT

2�traP

Canon Professional Services© 2004 Nick Wilcox-Brown



In the first article in this series, I went through some of the technical background to colour management giving an 
overview and some theory. In this part, I intend to give a much more down to earth overview of how to set colour 
management to work effectively with Canon Professional DSLRs.

Working with colour and not using a calibrated monitor is like trying to take pictures without an exposure meter. 
Now that the price of a hardware calibrator has fallen to only a couple of hundred euros, there is no excuse for not 
having one.

Working through a logical sequence, devices need to be set up in the following to order to form the basis of a 
colour managed workflow:

How to set up colour management

ruoloCfoegaugnaLehT
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Cameras  ->  Computer   ->  Monitor  ->  Printer
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Firstly I should say that these ideas for setup are aimed at photographers whose work will 
appear on the printed page, hence the recommendation for using Adobe RGB (ARGB) as 
the working space. 

 Link to : Colour Spaces

To recap slightly, ARGB is a wide device dependent colour space that was developed in 1998 
by Adobe Systems specifically for use in the pre-press industry. It has been adopted by many, 
including Canon, as a standardised space for high end digital cameras and increasingly as a 
universal standard for submitting images for publication.

Link to : Adobe RGB
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The Cameras
Currently there are four EOS bodies that fit under the Professional 
banner; the EOS-1D, the EOS-1D MII, the EOS-1Ds and the EOS-10D.
All of these are capable of outputting image data 
in the Adobe RGB colour space.

The setup for the EOS-1D and EOS-1Ds is identical. Menu > Camera 
tab > Colour Matrix 4 (all other colour matrixes are variations of 
sRGB, which is ideal for the web, but not for print).

The EOS-1D MII offers matrix 4 as Adobe RGB, but also offers the 
option to use 2 custom settings under matrix 6 and 7. Within the 
custom settings it is possible to choose Adobe RGB with different 
saturation levels and colour tones: At last it is possible to have 
highly saturated images in ARGB

For the EOS-10D, choose Menu > Camera tab > Parameters > 
Adobe RGB

There is one issue to beware of with all these cameras except the 
1D MII: Images recorded in Adobe RGB are not tagged with an 
Adobe RGB profile. It is essential to ensure that images are assigned 
that profile when opened in Photoshop, or poorly saturated images 
will result. On an Apple running OS X it is possible to use a pre-
installed Apple script to embed the correct profile when images are 
copied to a specified folder.

�
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The Computer
Regardless of whether you are using a PC or a Mac, the system and software needs to be correctly 
setup to handle images optimally.

On the PC, the settings are configured in Photoshop. On the Mac, the operating system (OS X) 
incorporates Quartz technology which intelligently applies colour settings on a system wide basis, 
so changes need to be made both in Photoshop and in preferences of the Colorsync utility.

Windows
Open Photoshop and go to Edit > Colour Settings. From the pull down settings menu choose "Europe 
Prepress Defaults". 

Macintosh
On the Mac, the colour settings for Photoshop need to be set up as above, except that Colour Settings 
are under Photoshop > Colour settings. In the advanced part of the setup choose 'Engine > Apple CMM'. 
In the past Apple RGB was the colour space of choice, but Adobe RGB is now the recommended space
for most uses. 

�
To configure system preferences, go to Macintosh HD > Applications > Utilities > ColorSync Utility and 
choose preferences.

For RGB Default, choose Adobe RGB, for CMYK, choose Euroscale Coated and for Grey, choose Generic 
Grey. Under CMMs, choose Apple to ensure consistency with the options in Photoshop. 

Depending on what version of Photoshop you are running and what other software is installed, the 
Euroscale coated option (to match Photoshop) may not be available. To get around this, go to 
Macintosh HD > Library > Application support > Adobe > Colour > Profiles and copy the Euroscale 
Coated profile and then paste it in Library > ColorSync > Profiles. Close all the windows and then 
open the preferences in the Colorsync utility and the option should be available.

�

System-wide colour settings on the Mac
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The Monitor
The monitor is straightforward to calibrate and profile on both platforms using the instructions 
supplied with your calibration device. Personally I have been more than happy with an Eye-One 
profiler from Gretag Macbeth (Eye-One display, approx €300, but there are other cheaper, 
devices available). 

The key points to remember are that monitors should be set for 6500° Kelvin (D65), gamma 2.2 
on both platforms. Previously, it was recommended on the Mac that gamma should be set for 1.8  
and the colour temperature to a very warm looking 5000° Kelvin, but Apple themselves now 
recommend Gamma 2.2 and the native white point of all their recent displays is 6500°.

The Macintosh actually has monitor calibration built into the system and the above options can be 
specified, but there are too many user subjective settings. For accurate colour rendition, hardware 
calibration is essential.

The principle of all device calibration is that the device is reset to know values and then the values 
are calibrated before a profile of the device is created. There is no point in carefully calibrating a 
monitor and then re-setting the brightness or contrast afterwards. Ideally a CRT monitor should be 
re-calibrated every couple of weeks and an LCD every couple of months, as devices change with 
time and age.

The calibration process is similar whichever brand of device or software is used. Once the monitor 
has been set to the nearest possible colour temperature, a calibrator is stuck to / suspended in front 
of the screen to measure the output. The black and white points are measured as well as the contrast. 
The colour output is then adjusted if it is possible (few LCDs allow this step). Following this, a number 
of colours are displayed in sequence buy the software and the monitor's response to each colour is 
measured, effectively mapping the colour range that the display can handle.

With the hardware and software configured, it should now be possible to output, high quality, 
colour managed image files from your digital camera. 

�

Gretag Macbeth's Eye-One match software 
comes with both the display and 

the Photo Calibration devices
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The Printer
The printer not only serves as a medium for providing hard copy, but with a little work, it can also 
provide you with accurate proofs of your output images. I have a Canon S9000 setup to do just that, 
and 99% of the time, the output matches printed images in magazines and brochures. If the colour 
printer has been made in the last two or three years, the chances are that it will able to output colour 
images close to what you see on your screen. The secret is in the settings and there are usually 
several ways of getting the same result. With minor variations the following settings are common to 
both the PC and the Mac and should guarantee a result with most printers including all from Canon 
and Epson.

Assuming Photoshop 7 or later, go to Printer setup and select your printer and page size. Next, go to 
'Print with Preview'. On the resulting dialogue box, there is a check box on the left side 'Show More 
Options', check this and select 'Colour Management'. 

The source space should be your working space, Adobe RGB, and the default Output Space should 
be changed as follows:

On the Mac, change from ' Same as Source' to 'Postscript colour management.' This ensures that the 
profile for your printer is used instead of the default setting of printing in your working colour space 
(which results in poor output). Choose 'Intent' >'Perceptual'.

On the PC, pulling down the tab should give you a selection of profile names. In the list will be the 
profile for the printer. The Canon S9000 for instance has a profile called "BJ Colour Printer Profile 
2000", the Epson 2100 is called "Stylus Photo2100/2200." 

�

The Print dialogue on the PC, showing the 
choice of output profile
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The Printer
In the printer dialogue boxes that will follow, the settings are more platform-specific.

On the Mac: By specifying 'Postscript colour management' we have specified that the operating 
system will be looking after the colour management. In the second print dialogue box, under 
'ColorSync' choose Colour Conversion > standard and under 'Colour Options,' choose Colour 
Correction > ColorSync 

On the PC: Colour management has been defined as being handled by Photoshop. In the printer 
dialogue box, choose settings > advanced or similar and under the 'colour adjustment' pull down, 
specify 'no colour adjustment' or 'Manual' > None, on the Canon

Ensure that paper and quality settings are correct and Print.

The resulting print should look much like your screen and if you are using a Canon printer, it will 
closely match your screen (Canon profiles, despite being generic, are extremely accurate).

Please note: There are so many ways to make changes to printer output. The above works on many 
models, but if you have a problem, check with you printer manufacturer's support desk to ensure 
that you have disabled / enabled colour managemnt settings correctly.

To further improve your output, it is useful to have your printer profiled. This means that your printer 
is calibrated with a specific paper and ink combination, at a set print resolution and then profiled to 
give outstandingly accurate output. 

If you have several printers and use a range of paper stock, Gretag Macbeth can supply a profiling 
system that allows calibration, not only of monitors, but printers too. This is called Eye-One Photo 
and retails for around €1600.

�

The Print dialogue on the PC, showing the 
choice of output profile
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What about colour management for RAW?
There are two answers to this depending on what software is being used. In both cases the choice 
of camera parameter is of no importance, as all the data from the imaging sensor is being output, 
not a sub-sample as would be the case with a JPEG. 

Using Phase One's C1, the files are automatically assigned a colour profile based on the EXIF 
information. This means that a file from an EOS-1Ds will be automatically assigned a camera model-
specific input profile and colour managed during the processing by the application. On output, it will 
be assigned with the chosen output profile, typically Adobe RGB or a CMYK space such as Euroscale 
Coated. For more precision, it is possible to specify the preferred input profile or even a custom made 
profile for a specific camera if you are of the perfectionist persuasion.

Using Adobe's RAW converter, the system is much more closed the input profile is ignored, so only 
the output profile can be specified. The only way to use a custom camera profile is to assign it as the 
output profile and then convert to a working space; workable, but not ideal.

Summary
You now have a colour managed workflow.

To summarize what we have done: The image is captured in the Adobe RGB space and transferred to 
the computer. Because it has been assigned an ARGB profile on opening, the colours are known values 
to the computer, which means that they are rendered correctly on screen. Thye are then output with an 
embedded ARGB profile. When the next user down the line opens the image, their system will read the 
profile and again, display the colours exactly as you have seen them. 

The final link in the chain is creating a print that matches what you see on your screen, and if you have 
not made substantial changes, that matches the subject too. By shooting Raw images, we can maintain 
this workflow, but give a little more flexibility in terms of exposure, adverse lighting and ultimately a 
higher quality file, by generating a lossless TIFF file as opposed to a lossy JPEG.

Nick Wilcox-Brown.

�
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The basics of colour management are not hard to grasp, but it is details that can cause the most confusion. Rather 
than continuing with further ideas this month, I am going to go through and clarify some details and provide a 
simple way to achieve correct printed colour in the real world.

Excepting the new EOS 1D Mk II, the current EOS DSLRs only embed sRGB colour profiles, not Adobe RGB. Once 
the decision to open a file in Adobe Photoshop, there is no way of knowing exactly what colour space it was shot 
in without checking camera settings. It is critical that an image is tagged with the correct profile, as an incorrectly 
tagged image will never reproduce properly.

Continuing to work on the recommendation to shoot in the Adobe RGB colour space as described in Article 2 , the 
images will have no embedded colour profile.

Because these images have been shot in the Adobe RGB space, it is essential to convey that information to the 
computer by ASSIGNING the Adobe RGB colour profile to them. This ensures that they are correctly handled and 
displayed by Photoshop. Using Photoshop's powerful automation tools, this can be set up as a batch action, or a 
droplet.
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Assign or convert?

ASSIGN a profile to an image when you know what space it has been shot it in, but is has no attached profile (it is 
untagged). If you use a 1D to shoot jpeg in Adobe RGB then ASSIGN the Adobe RGB profile to the image when it is 
opened in Photoshop.

CONVERT an image from one colour space to another; an image is converted from RGB > CMYK for example.

Common problems

Some of the most common problems that photographers suffer with their digital images are related to assigning 
and converting images. The problem can be self-inflicted or at the hands of the printing industry.

Self-inflicting the problem means that the photographer opens an image, shot in the Adobe space, without 
assigning a profile and the image is treated as sRGB by default. On screen, the images will look flat and under-
saturated and in print, the result is even worse. Following the above suggestions and using a calibrated monitor 
will prevent this occurring.

Shot on an EOS1Ds, in Adobe RGB, this image 
was correctly assigned the Adobe RGB profile

The same image was mistakenly assigned
with the sRGB profile, creating a washed-out, 

under-saturated image.
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Simple solution

To do this is very simple: Save a high quality version of your prepared file in Adobe RGB as a TIFF image for the 
archive and then send the client a TIFF that has been CONVERTED from Adobe RGB to sRGB. Some would say that 
a proof of the image should also be supplied, but in truth, only a CMYK proof is of any value, as will be seen later.
 
In Photoshop: Image > Mode > Convert to profile and choose sRGB

When doing the conversion, the following window appears:

Rendering intent defines how colours will be translated when moved from one colour space to another. 
Photoshop's default is relative colorimetric, but using the preview checkbox, compare the results between relative 
and perceptual, traditionally the choice for images. Never use absolute colorimetric or saturation; the latter is 
designed for business graphics and absolute colorimetric takes into account paper colour and other factors that 
are not defined for the purpose of this conversion.
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How to survive printers

Currently the pre-press and printing industry is in an even bigger state of flux than the photographic industry. 
Historically they have been supplied transparencies and colour management consisted of operators matching 
their screens to the press output; the classic closed loop system. The problem with these systems is that they 
rarely work when files are introduced from the outside.

There are some excellent printers around, but it is still the norm when checking the Macs at even the biggest 
printing houses, to find that Photoshop is still configured, as it was when it came out of the box, i.e. the default 
RGB space is sRGB (or in some cases, the monitor space) and the default setting is to ignore embedded profiles. 
In some cases, colour management will actually be turned off - it stops operators having to close the same boring 
pop-up box all the time - the one that says "Profile Mismatch"!

Cynically, it is possible to say that however much hard work you have put into colour managing and enhancing 
your images, the profiles my be ignored and they may be turned into sRGB images making them look flat and 
washed out.

Pragmatically, it is better to look on this as a short-term problem. Apple, Adobe and others are working very hard 
to educate, advise and setup colour managed ICC workflows in the printing industry and the money is on Adobe 
RGB becoming the working space of choice. In the interim period, it is worth taking precautions to ensure that 
your images reproduce accurately. Assume that the magazine / repro house / printer is going to mistreat the 
images and be prepared for it by supplying all RGB images in sRGB (At this point, it is worth mentioning that any 
images supplied for the web should always be supplied in sRGB, never in Adobe RGB).
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Software tools for colour

In Article One of this series, there was a diagram comparing the relative colour spaces of Adobe RGB and the 
smaller, but commonly used Euroscale Coated CMYK space. A similar diagram can be created in Apple OS X by 
using the ColorSync utility in the Utilities section of the Applications folder. 

By going to the profiles menu and selecting one of the profiles, it is possible to plot any profile in 3 dimensions. A 
hidden but clever feature, is to select a profile such as Adobe RGB and then by clicking on the triangle in the top 
left of the window and selecting 'hold for comparison', it is possible to select another profile to compare such as 
sRGB.

For windows users, there are no such luxuries in the operating system, but the excellent ColorThink 2 software 
created by Steve Upton of Chromix (Martijn, please hyperlink, separate window, to http://www.chromix.com), is 
available for both platforms and does all the same things and far more as well for $149. The usefulness of such 
software becomes more evident when frequent changes of colour space become necessary, particularly when 
converting images from RGB to CMYK. It is possible to see clearly on the graphs exactly which colours are going 
to be affected by conversions and also, which colours simply cannot be reproduced in CMYK. These colours are 
termed 'out of gamut'. 

ColorThink has been used to plot all the colours in an image against the sRGB colour space. 

The stray dots are 'out of gamut', that is they lie outside of the colour space. How they are 

bought into the space is defined by the rendering intent. This will e covered in more detail in 
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Too much compromise?

Supplying sRGB images works, but it is very much a case of bringing your work down to the lowest common 
denominator. For those who feel it is too big a compromise or a sell out after the hard work of putting into place a 
fully colour managed workflow, then the proactive alternative is to supply images in CMYK.

CMYK has always been portrayed as frightening prospect for mere mortals, but with a properly calibrated monitor, 
Photoshop's excellent soft proofing tools and the availability of reliable, standardized profiles, the process need 
not be nearly so daunting as it is frequently portrayed.

One comment that is often made by printers is that Photoshop is not capable of a good CMYK conversion. Ignore 
it: That inaccurate view dates back 10 years or more to version 2 and 3. In more recent times it is more related to 
the fact that anything converted into Photoshop's default SWOP CMYK is going to look awful however it is printed, 
than which colour engine used in Photoshop. Using the correct profiles, Photoshop is as good as the rest; it is 
down to the operator's skill and knowledge, not the tool.

In Part 4, I will go through conversion of images into CMYK in detail.

Nick Wilcox-Brown © 2004
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Converting to CMYK

Long the cause of fear for many, CMYK conversion is not the monster often portrayed, merely a few clicks of the 
mouse… 

In Part 3, I suggested what can only be described as a pragmatic approach to surviving the printing industry. Many 
will probably think it foolhardy to set up a colour managed workflow and then hand over sRGB images to a printer. 
In the longer term, colour management will be implemented in more organizations and the standard for supply 
will be a high quality RGB space like Adobe1998. In the short term, the alternative strategy is described below; 
namely to go the full distance and supply fully colour managed CMYK images to the client or printer.

There are certain things to be borne in mind when taking this approach: By providing CMYK images, it will be 
assumed that you are confident and know what you are doing - if you have any doubts whatsoever, supply in RGB. 

If you are happy to continue, basic CMYK conversion is straightforward using the proofing tools included in 
Photoshop. More advanced techniques are the subject of whole books and are a skill that should not be 
underestimated. 



ruoloCfoegaugnaLehT

4traP

It is essential that you supply accurate proofs with your images, a quick inkjet of an RGB file is not good enough as 
it will contain colours that cannot be matched on a printing press. A proper cross-rendered file from an inkjet 
provides a very usable guide print, so as usual with anything colour related, an accurately calibrated monitor and 
printer are essential tools.

Before you start, a few questions: 
- What is the intended use of the image(s)? 
- Do you have a profile for the printing press?
- What media will they be printed on? 
- Web offset (like newsprint) or sheet fed printer? 

The questions are important as they help us to decide how the file will be supplied and what CMYK space we will 
convert to. In a more advanced workflow, the information would also help us to decide maximum ink limits and 
other factors, but that is beyond the scope of this article.

Remember that we are re-mapping numeric values of colour from one location to another. Put simply, RGB is a 
large colour space and CMYK is a small space - images have to be translated for the larger to the smaller space. 
The rendering intent determines how this translation is done. 
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Assign or convert?

Most important is to set up Photoshop correctly:

Firstly:  Mac: Photoshop > Colour Settings 

  PC: Photoshop > Edit > Colour settings

On both platforms, choose "Europe Prepress Defaults" from the settings pull-down. This sets your default CMYK 
space to 'Euroscale Coated v2', a useful CMYK space that suits a broad range of high quality uses when the output 
is to be printed on typical European presses, on coated paper. 

If you know that the paper is uncoated (quite unusual), the 'Euroscale uncoated' profile can be used. 

In Colour Settings > Working spaces, Choose 'Load CMYK' to load a profile from the system or one that has been 
supplied (see screen shot)
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Custom profiles should be loaded into the following location:

Mac (OSX Panther) User > Library > ColorSync > Profiles

PC (XP) Windows > System32 > Spool > Drivers > Color

In some cases, printers may specify custom settings rather than provide a profile. To utilize these settings, choose 
Working spaces 'Custom CMYK' which will bring up a dialogue similar to the screen shot below.

Maximum ink, Dot Gain and other settings should be input as directed. If no ink colours are directed, they should 
typically be configured in relation to the location where the printing will be done and the paper type i.e. 
Eurostandard Coated or SWOP for the US.
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Soft Proofing

Once the CMYK colour space has been set the document need to be 'soft proofed' to ensure that it will convert 
correctly to CMYK.

In Photoshop, the normal way to do this is to go View > Proof setup (Mac Apple + Y / PC ctrl + Y)

Assuming that the CMYK profile has been correctly set as the working CMYK space then View > Proof Colours will 
give a proof of the image as it will appear in CMYK.

This way of working has some disadvantages: The rendering intent is set in colour settings and is effectively fixed. 
The rendering intent is what determines how 'Out of Gamut' colours are translated from one colour space to 
another.

 Traditionally photographs have converted using a perceptual setting but this may not be the most appropriate 
depending on the colours present in the image. The other alternative is Relative Colorimetric. Do not use 
'Saturation' or 'Absolute Colorimetric'.

The better way of working is to configure Proof setup > Custom

Choose the profile you want to proof in the ‘profile’ tab, leave ‘black point compensation’ checked and leave the 
two ‘simulate’ boxes unchecked. Finally save one version of this setup as “(profile name)_relative” with rendering 
set as relative colorimetric and another as “(profile name)_perceptual” with the rendering intent set to perceptual.

It is now possible to proof with either rendering intent to see which gives the best conversion.
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Gamut Warning

View > Gamut Warning (Mac Apple + Y / PC Ctrl + Y) shows a visual representation of colours that will not 
reproduce in the chosen colour space by overlaying a light grey colour. You may say "Well, so what?". Actually this 
is a very important feature as it highlights colour that may cause an issue and allows adjustment before 
conversion. Typically when moving from Adobe RGB to Euroscale Coated, the only major issues that will occur 
amy be with yellows. With sRGB, a much more limited space, there are far more issues. This can be clearly seen 
from the image below, showing the colours that are out of gamut when the forge image, in sRGB, is about to be 
converted to CMYK.
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Hard Proof 

The  final stage before conversion is to create a proof to be supplied to the client with the images. This proof will 
effectively be a Guide print; a match print for the client and the printer.

The print can created in several ways, but by far the simplest is to “Print with Preview” (Mac Apple + P /PC ctrl + Alt 
+ P) as seen in the image below.
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Hard Proof 

The  final stage before conversion is to create a proof to be supplied to the client with the images. This 
proof will effectively be a Guide print; a match print for the client and the printer.

The print can created in several ways, but by far the simplest is to “Print with Preview” (Mac Apple + P 
/PC ctrl + Alt + P) as seen in the image below.

Check “Show more options” and choose ‘Colour management’

Select the source space as 'Proof' which will be you CMYK space and the destination will by default be 
“Same as source”.  Ensure that you change 'Print space'  to the icc profile for you printer and use 
‘Rendering intent’ ‘Relative Colorimetric’. For hard proofing, ensure that 'Black point compensation' is 
turned off. This proofing process is called Cross Rendering. 

Click print and then set up the printer as normal i.e. High or maximum quality, 
correct media for the profile and very importantly, ensure that  colour 
management is set to ‘Off’ or ‘None’ in the printer driver.

Print.

Once dry, the printed image should now provide an accurate proof of the 
image supplied on disk or by ftp / email after conversion.
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CMYK Conversion

Having checked the conversion on screen with a soft proof, remapped colour shown up in the gamut warning 
and made the final check with a hard proof, we are ready for the actual conversion.

The normal way to do this is Image > Mode > CMYK colour. 

A better way, in my opinion is the following: Image > Mode > Convert to profile
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This option is useful for many conversions and for CMYK conversion, particularly so as it allows a preview prior to 
the conversion. Once again, you can check whether the image translates correctly from once space to another and 
if you are using the best rendering intent for the image in question.

For the actual CMYK conversion, it is very important to ensure that ‘Black point compensation’ is checked as seen 
below. The purpose of this is to re-map the minimum black value from one space to another, ensuring that the 
entire dynamic range of the image is translated correctly to CMYK, guaranteeing that no shadow detail is lost. 
Interestingly, this feature is an Adobe fix for a gap in the ICC specification for colour profiles.

Anther point of note: There is no benefit to the images being left in 16 bit colour for the purpose of the CMYK 
conversion, so if this makes the workflow easier, do the 16 > 8bit  conversion earlier.

Convert to CMYK!

You’re finished; CMYK conversion completed
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Further points

The above conversion was straightforward and because of the use of what are effectively, Adobe profiles, the 
matching from one space to another is consistent and out of gamut colours are not a major issue.

Many profiles supplied for presses are not so easy, but the same principles apply. 

The most useful tool is 'Soft Proof' - Mac Apple + Y / PC Ctrl + Y and you have a preview of how the image will 
translate. Often with CMYK conversions, the file will appear lighter when the soft proof preview is turned on. As 
long as your monitor is accurately profiled and you had black point checked when configuring the proof settings; 
trust the preview. If this means adjusting the levels in the image to get the right density, go with it. The final 
hardcopy proof will allow a final check before supplying the image to client.

In the absence of a supplied profile from client or printer, the recommendations about which CMYK space to use 
vary. The two popular suggestions at this moment are as follows:

- Euroscale Coated v2 supplied by Adobe
- ISO Coated supplied by the European Colour Initiative (ECI)

These profiles are similar and both aimed at quality printing in a European environment. Additionally ECI offer 
profile for Uncoated papers and a profile for web offset printing (as opposed to sheet fed). These can be 
downloaded for free, with information on their usage from the ECI choose the file: ECI_offset_2004.sit 

One final warning, if you are using a version of Photoshop before 5.0 (5.5 on PC) upgrade it now: by general 
consensus, colour management was not properly implemented before that version and ideally version 6 should 
the earliest version used. On the same tack, never use SWOP CMYK profiles unless supplying files for printing in 
the 'States. These profiles are designed for American inksets and files in these spaces print very badly on 
European presses.

Nick Wilcox-Brown © 2004
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Every camera is slightly different and while generic profiles provide a good basis for colour that is very close to 
what the camera has ‘seen’, the only way to achieve absolute accuracy is to profile the individual camera.

Profiling the camera is the last piece of the jigsaw in terms of getting absolute colour accuracy in your workflow. 
A digital camera profile has been described as a ‘colorimetric’ interpretation of a camera’s behavior under a 
specific light source. Because this direct interpretation does not always lead to the best visual result, it is 
important that there is some flexibility in the way that profiles are generated to suit individual tastes and 
requirements. To that end, the software described offers a great deal of flexibility and may change perceptions 
about the role of the profile in the workflow.

To left is a general purpose profile, designed to be neutral and representing lighting conditions when the image was 
shot, to right a more saturated sunlight profile to enhance the image 

 IMAGES©2004 Nick Wilcox-Brown
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Profiling sounds like a complex task, but is in 
fact remarkably straightforward. Ideally each 
camera requires two profiles, one for daylight 
and one for tungsten light. This is because the 
response of the chip at 3400 Kelvin, where the 
light has a far higher red content, is very 
different to that at 6500K, the value typically 
taken for daylight. Think of it as using tungsten 
film and daylight film.

In the past there was limited range of software 
for performing such tasks from only a couple 
of manufacturers including GretagMacbeth 
and Monaco systems. In the last couple of 
years the choice has mushroomed and there is 
a choice of systems ranging from Photoshop 
plug-ins to full-blown systems with hardware 
devices that do far more than simple camera 
calibration.

I have chosen to test GretagMacbeth’s add on 
module to their popular ProfileMaker 5 
software, the DC module. Whilst not being the 
cheapest solution, GretagMacbeth have an 
enviab le reputation for the quality of their 
products.

The Digital Colour Checker SG Chart, newly designed for 
ProfileMaker 5 with a specially optimized surface to ensure 

maximum black values and maximum saturation in the 
coloured squares. Towards the bottom of the chart are a 

group of patches used to represent facial tones commonly 
used in the cosmetics industry

The whole process is very straightforward; the only 
significant issue is how to get the best quality image of the 
test chart from the camera into the software in the first place 
– more of that in a moment.

The procedure is as follows:  
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Part of the procedure involves choosing options for how the profiles will be used. Options include Product 
Photography, Outdoor, Portraits, General Purpose, Black & White and Reprographic.

According to GretagMacbeth any of these settings will provide high quality profiles without the need for 
customization. However, the customization options for profiles are where the power of the tool really becomes 
obvious. 

Cropping the test chart. To top right is 
a magnified view for added precision 

when positioning the crop lines
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Ensure that lighting is totally even across the chart and 
that the camera is precisely setup and square to the 
target. Ideally the best way to capture the image is in 
RAW mode or with JPEG, the colour balance should be 
fixed at the temperature that you are aiming to profile 
for. Most typically this will be daylight, 6500K or 
tungsten, 3400K. For the daylight profile, flash 
provides a similar result to daylight without the 
inconvenience of clouds, rain and insects. Optimally 
two flash heads will be used with softboxes, at 45° to 
the target; the classic reprographic setup.

The chart should be shot as near full frame as possible 
and the image transferred to the computer and 
processed, ideally as a 16bit TIFF. A JPEG shot in 
Parameter 4 (Adobe RGB) will work quite successfully, 
but the image will not reflect all the colours that the 
camera can reproduce and may not produce the most 
accurate profile.

My own workflow involves processing the RAW file 
through Phase One’s C1, with sharpening turned 
off and the output set as ‘Embed Camera profile’. 
Effectively this means that the colours are 
unchanged through the processing. By doing a 
click white balance on one of the light grey patches, 
I can be confident that the image is 100% neutral. 
ensuring the most accurate profiling possible.

Once the image has been saved as a TIFF or JPEG, 
the image can be imported into ProfileMaker. The 
software works by comparing known values with 
captured values for the colors and creates a profile 
based on the difference and the options taken. 
Once again, colour is shown to be a numbers 
game.
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In the screenshot on the left, the standard camera-
profiling window from PM can be seen. To left are 
the images for the charts, to right, pull-down tabs 
for options.

The reference chart is chosen in the top window and 
then through a browser interface, the captured 
image of the chart is selected in the lower window.

Once the image has been selected, the window 
below appears and crop marks are dragged into the 
extreme corners of the chart to ensure that the 
software is capturing target data with no extraneous 
information. A magnified view is shown to top right 
for added precision.
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The first time I opened the options panel, my reaction was one of “Why do I want exposure correction or 
contrast options in a camera profile?” In fact different camera profiles can be used for a wide range of 
purposes, to achieve image effects on a batch basis or to correct for a known situation. If extra contrast is 
needed to achieve a particular look, it is simple to create a camera profile that increases it for every image. 
Similar options can be applied for clients who prefer a more saturated look to the image or where a whole 
set of images needs to be output as black & white.

Once all options have been selected, the profile can be created or the job added to a batch to create multiple 
profiles at once. Profiles are saved, by default in the user profiles folder on the Mac or the system profiles folder 
on the PC.
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A further pull-down provides options for standard lighting conditions that profiles can be 
created for. These include D50 (5000K), D65 (6500K), HMI, a range of fluorescents and 
variations of Tungsten. For owners of hardware measuring devices like the i1 Pro, the ability 
to measure and configure a profile for a specific light source is available, imported from data 
generated by the free EyeOne Share software.

For product photographers, clients may require key colours to be reproduced perfectly as part 
of their packaging or logos. Using the spot colours option, it is possible to measure these 
colours and add them to the profile as custom colours, ensuring that they reproduce with 
100% accuracy when the profile is generated.

ProfileMaker 5 offers a very straightforward interface that can quickly provide an accurate 
profile for a camera. I’m tempted to say that with such a fast and simple workflow, this could 
be done on a per-job basis, if the work merits it. 

The key point to achieve accuracy of the profile is the quality of the file that is fed into the 



ruoloCfo
egaugnaLehT

Why profile your camera?
Does it really make a difference?

5traP
�

I have done a lot of testing to work out the best way 
of creating an accurate ‘input’ file. Ideally the data 
wants to be unprocessed and RAW provides the best 
solution for that. Unfortunately, most of the RAW 
converters on the market are colour savvy, but few 
have the ability to specify both input and output 
profiles which is why I have adopted C1 for my own 
purposes. Both Photoshop and Canon’s File Viewer 
Utility can be made to work, but the procedure is 
more time complex and time consuming.

In Canon File Viewer Utility, the procedure is to 
import the RAW file, neutralize the grey balance and 
output the file as an Adobe RGB file before 
importing it into ProfileMaker5. After creating the 
profile, it must then be assigned to the original 
image (not converted) and to any other images that 
it will be used with. This will also apply to JPEG files 
that are taken direct form the camera.

The above principle also works with Photoshop CS 
RAW converter. The key point is not to make any 
changes in the RAW software except neutralizing the 
greys. From Photoshop CS, the image can be output 
into a larger space such as ProPhoto or EktaSpace. 

Once again the profile will need to be assigned to all 
images after processing and, as before, converted to 
a regular space like Adobe RGB for use in the 
workflow. The same applies if camera JPEGs are 
used instead of RAW files.

C1 differs in that it allows the created profile to 
automatically applied, used for processing and 
processed images are then output into a chosen 
colour space.

Camera profiling is not for everyone, but for those 
who enjoy the challenge of obtaining the best 
possible result or those who need absolute colour 
accuracy, the ProfileMaker 5 DC module offers a very 
competent and affordable solution. 

For those who really take their colour seriously and 
already own an i1 Pro device, there is the possibility 
of attaining further perfection by hand measuring 
the SG chart. Did you know that by using i1 Share, it 
is even possible to measure the spectral values and 
color temperature of both flash and continuous light 
sources used for profiling?

For further details of GretagMacbeth go to http://www.gretagmacbeth.com

Photostudio Bundle (inc i1Pro & SG chart) €¤3845

Photostudio Software (inc SG chart) €¤2745

DC Module €¤435

SG Chart €¤325

Approximate pricing
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The Language of Colour was always meant to be in 5 parts but now we are at an end, 
I thought it a useful point to provide some updates and links to further reading.�

Firstly, it is worth mentioning that the Language of Colour is now downloadable in its 
entirety from the CPS website  as a complete .pdf document.

Over the past few months I have aimed to go through the basic processes of colour 
management for photographers. For some this is too much detail, for others, not 
enough.

Colour management, like many subjects in life, is something that is constantly 
changing, there are many differing points of view and there is always more to know.
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Books

I have learnt a great deal over the years from many articles, books and 
more recently web sites. In the last few months a group of the great 
gurus in the colour world, Bruce Fraser, Chris Murphy and Fread Bunting 
have published what can only be described as a seminal work:  "Real 
World Colour Management" by Peachpit press (ISBN: 0321267222). If 
you want to know more about colour, get the book.  I only wish it was 
around when I started writing these articles. 

Another book that is often quoted, but far more technical in its approach 
is "Understanding Color Management" by Dr Abhay Sharma, Published 
by Delmar, ISBN: 1401814476.

Monitor Calibration

Colour management has been getting a great deal more press in recent 
months and most photographers are now aware of it, even if they are 
not fully up to speed. In parallel with this increasing awareness, there is 
now a greater range of 'affordable' monitor calibration devices available 
from a range of manufacturers. 

Readers will be aware of my point of view on monitor calibration, the 
same old question: Would you take pictures without a light meter in your 
camera? If the answer is no, then how can you presume to correct colour 
without a calibrated monitor? The monitor is the photographer's only 
window on the digital files they shoot.
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A quick look through a couple of web stores yields the following 
list of monitor calibration devices. When I started writing this, 
the starting price was around € 250:

Colorvision Colorplus   
Colorvision Spyder  
Monaco Optix   
Eye One Display 2   
BasIC Color Squid   
Eye One Photo   
(Prices are net of VAT)

My personal favorites, the Eye One range by Gretag Macbeth has 
just had the entry level model updated to allow it to read the 
ambient light in the room as well as calibrating the monitor. 

Ambient light is often overlooked when people buy these 
devices. It is no good putting the monitor facing a bright 
window or with a window behind; lighting needs to be relatively 
constant in an area where critical colour work is being 
undertaken. The Display 2 allows the ambient light to be 
checked to see if it is in the optimum range for colour 
correction. 

On the same basis, walls need to be painted in neutral colours. 
It is proven fact, that if you work in a pink room, you will tend to 
correct your images to compensate, so if your clients tell you 
that your images are green you know where the problem lies.

€ 100
€ 135
€ 210
€ 240 
€ 310
€1000
(Prices are net of VAT)

Granger's Rainbow, the perfect way to test 
colour profiles

By assigning a colour profile to the rainbow image 
it is possible to check for a bad profile; one that
causes the patter to change dramatically or to�

cause holes in the patter
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RGB / CMYK Conversion

CMYK conversion is always a thorny subject. More often the question starts out as "What is the best 
way to give my images to my clients / to a printer?"

It probably became apparent from the articles that there are currently no hard and fast rules. Since 
the article was published I have had many interesting discussions with photographers and colour 
consultants from all parts of the globe, all have the same problem: The printing industry currently 
has no global or even national standards and frequently relies on the closed loop of monitor 
matches printing press, with no standardized calibration.

Currently I supply sRGB and / or Euroscale Coated v2 files to unknown printers, always 
accompanied by a cross-rendered proof of the image. Cross-rendered means that the file is 
effectively converted to the selected proof space in the background by Photoshop and then into the 
printer's colour profile (chosen as the print space in Print with proof > more options > colour settings 
in Photoshop). Most inkjet printers have a far wider gamut than the average printing press and this 
process ensures that the colours on the proof are reproducible in CMYK.

For known printers, the routine is to supply in the much wider and more useful Adobe RGB space or 
in one of the ISO CMYK spaces. This only works if you have confidence that the printer knows how to 
handle the file effectively

To re-iterate: Beware supplying a file in Adobe RGB file to an unknown or non-colour managed 
client or printer. Photoshop's out-of-the-box settings mean that an Adobe RGB file may be assigned 
an incorrect sRGB profile and print as a desaturated image, often with a slight colour cast.

Despite all precautions approach, things can still go wrong: I recently supplied a file to a printer, as 
requested, in Euroscale Coated CMYK with an accurate proof. The job was important and for one of 
my best clients, so I requested the printer supply a final press proof of the job for me to check.
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When said proof arrived, it was not good and delicate shadows had gone from an early morning blue to a 

muddy green colour. When I questioned the printer what had gone wrong and why it did not match the 

proof that I supplied with the file, I was told "Oh, don't worry about that mate, the print will not match the 

proof"

What more can be said? The final output actually matched my proof perfectly. 

Take every precaution, always send a proof and keep another copy of the proof in the filing cabinet, just for 

safety.

Here are some helpful web sites that provide interesting links to further information:

Web Sites

Pixl     						

Colourmanagement.net    

Colour Collective  

Chromix   

Gretag     

International Color Consortium 

European Color Initiative   

Enjoy!

Nick Wilcox-Brown 2004

Nick is a photographer and runs a consultancy business, The Image Consultancy, providing specialist colour 

management and digital workflow configuration and training.

http://www.pixl.dk/

http://www.colourmanagement.net/

http://www.colourcollective.co.uk/

http://www.chromix.com/

http://www.i1color.com

http://www.color.org/

http://www.eci.org




